
Contract Administrator

Getting started



NBS Contract Administrator
Getting Started Guide
Welcome
Thank you for choosing to subscribe to NBS Contract Administrator. This product has been designed to support the decision 
making, communication and information audit trail that are key to effective administration of construction contracts.

NBS Contract Administrator v2.0 will support JCT 98, IFC 98, MW 98, SBC 05, IC 05/ICD 05, MW 05/MWD 05 forms of 
contract as well as generic forms of contracts SBC SCOT 05, MW/SCOT 05, MWD SCOT 05. At the heart of the system are the 
well-known RIBA forms for contract administration.

NBS Contract Administrator has been designed to be simple and intuitive to use. Forms, team details and reports are 
organised in the panel on the left hand side of the screen. Each job can be simply located, its history reviewed and new forms 
generated.

The Editor in the centre of the screen is used for editing forms and job details. The Guidance panel on the right hand side 
of the screen displays contract administration and editorial guidance, which is synchronised with the content of the Editor.



Contents of this guide

This guide covers the four straightforward steps that you need 
to complete to start using NBS Contract Administrator:

Installation 
NBS Contract Administrator can be installed either to a 
standalone machine or on many machines across a network 
environment.

Licensing 
NBS Contract Administrator must be unlocked by entering a 
licence code obtained from NBS.

Create a data store 
This will store all of the job information and can be located on 
a standalone machine or shared on a network location.

Set up practice details 
These are the ‘issuer’ details that will appear on all contract 
administration communications.

Once you have successfully completed these steps you are 
ready to start using NBS Contract Administrator. You can:

Explore the demo jobs 
NBS Contract Administrator is supplied with demo jobs 
containing examples of completed forms and reports. These 
allow you to quickly explore and understand the software 
before creating your own jobs.

Create a new job  
It’s simple to set up new jobs and quickly start creating 
contract administration communications.

The guide also contains:

Sources of further help and support  
As well as extensive help and guidance within the software, 
NBS Contract Administrator subscribers benefit from free 
telephone and online technical support.
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Installation

For Windows 2000, XP and Vista; ensure that you are logged 
on to the machine with an account that has administrator 
permissions, which are required to install the software. Insert 
the NBS Contract Administrator CD. If autorun is enabled on 
your computer, the installation process will begin
automatically. Otherwise, browse to the CD and double click 
on NBSCA.exe, the NBS Contract Administrator start-up 
pages will now display. The startup pages include detailed 
step-by-step installation instructions. It is essential that 
Internet Explorer 6 is installed before you install NBS Contract 
Administrator.

1. Select Install or upgrade NBS Contract Administrator.

2. If your computer does not have the Microsoft .NET 		
	 Framework v2.0 already installed, you will be prompted to 
	 install it; select Yes. This is required by NBS Contract 		
	 Administrator. You may be prompted to restart your 		
	 machine during this process, and you must do so before 		
	 continuing with the installation.

3. Once the Microsoft .NET Framework v2.0 has been 
	 installed the NBS Contract Administrator installation will 		
	 resume and the installation wizard will appear. Click Next.

4. On the next step carefully read the Terms and Conditions 	
	 and select either Accept, continuing onto the next step of 	
	 the installation, or Not Accept and exit the installation 		
	 wizard. Click Next.

5. Enter details of your user name and organisation in the next 	
	 step of the installation wizard. Select to install the software 	
	 so that it can be used by any user of the computer or 		
	 restrict the software to the account that is logged on to the 	
	 machine at the time of installation. Please note: that 		
	 choosing to allow access only to a single account will 		
	 prevent other users from accessing the software if they log 	
	 on with a different account. Click Next.

6. You will then be prompted for the location where you 
	 wish to install the software. The default location is 
	 C:\Program Files\NBS. Click Next to accept the default 
	 location or click on the Change button to browse to a 
	 different folder on the local machine. Click Next to 		
	 continue.

7. The installation process is now ready to begin. Click Install 	
	 to begin the installation or use the Back button to review or 	
	 change your installation settings. After the installation has 	
	 finished, click on Finish; there is no need to restart your 		
	 machine.
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8. On completion of the installation process start the software 	
	 by selecting Start, Programs, NBS and NBS Contract 		
	 Administrator from the Start Menu, or double click on the 	
	 desktop shortcut.

9. When you attempt to run NBS Contract Administrator for 		
	 the first time after installation, the licensing wizard will start 	
	 to guide you through the steps required to generate a 		
	 Request Code and unlock the software. 

Licensing – Network

When you attempt to run NBS Contract Administrator for the 
first time, the licensing wizard will start, to guide you through 
the steps required to generate a Request Code and unlock 
the software. For network installation, it is essential that NBS 
Contract Administrator is installed, licensed and data store(s) 
created for one network machine first. After this, the software 
can be installed on other network machines which can be 
licensed and setup by browsing to the licence files and data 
store(s) created during the first installation; see subsequent 
installs.

First Install 
1. To create a new licence file select New and click Next.

2. Select a location to store your licence file; this can be a 		
	 UNC path, or a mapped or shared drive, e.g. 
	 \\server\LicenceFile. 

3. The software will now generate a Request Code and 		
	 prompt for an Unlock Code. You can obtain your Unlock 		
	 Code by telephoning NBS Customer Services on 
	 0845 456 9594 and quoting the Request Code. Enter 
	 this Unlock Code and the software will be activated for 
	 use.
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Subsequent Installs 
1. Select Existing and browse to the location of your licence 	
	 file, e.g. \\server\LicenceFile.

2. The software will be activated for use. 

Licensing – Standalone

When you attempt to run NBS Contract Administrator for the 
first time, the licensing wizard will start to guide you through 
the steps required to generate a Request Code and unlock 
the software.

1. To create a new licence file select New and click Next.

2. Select a location to store your licence file. NBS 
	 recommend that you create a backup of your licence file 
	 for future use; 	select a location to store your licence using 	
	 the browse icon. The location must be on your machine’s 	
	 local fixed drive.

3. The software will now generate a Request Code and 		
	 prompt for an Unlock Code. You can obtain your Unlock 		
	 Code by telephoning NBS Customer Services on 
	 0845 456 9594 and quoting the Request Code. Enter this 	
	 Unlock Code and the software will be activated for use. 

Create a data store using the data store 
Setup Wizard
Once the software is licensed it will prompt you for a location 
for the data store in which to store the job information. To offer 
the maximum flexibility, an office can have one or more data 
stores and these can be located on individual machines or on 
a shared drive regardless of whether you are a standalone or 
network user. 

Popular options are:

Individual data stores 
Create a data store by selecting Create a new data store 
option on the data store setup wizard and selecting Next. 
You can then browse to a location for the data store file to 
be stored; this should be held locally and therefore will be 
individual to users on that machine. If you have an existing 
data store use the Use an existing data store option in the 
wizard and select Next, you will then be given the option to 
browse or search for your data store.

Single data store for multiple users 
To allow all NBS Contract Administrator users in the office to 
access the same set of projects: Create a data store on a 
network locations (UNC, shared or mapped) from the first 
NBS Contract Administrator installation using the Create a 
new data store option, select Next and then browse to the 
desired location. For any subsequent installations, use the 
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Use an existing data store option and the select Next to
browse to the folder that the data store is located in.

Practice information (Issuer Setup)

NBS Contract Administrator automatically completes the 
information about your office on every form. The software will 
prompt you to enter this information after you have set up a 
data store. You can later change this by selecting Edit Issuer 
Details from the Tools menu. 

NBS Contract Administrator Interface

NBS Contract Administrator has been designed to be 
simple and easy to use. The key parts of the NBS Contract 
Administrator screen are shown in the illustration overleaf.

Demo jobs

NBS Contract Administrator includes demo projects for a 
selection of the supported contracts. NBS have authored 
these to allow users to familiarise themselves with the 
software and the range of forms available.

Accessing a demo job 
To access the demo jobs select Demo Jobs from the View 
menu. The demo jobs are listed in the Job panel. Double 
click on one of the demo jobs to open it. The Job Details will 
be displayed in the Editor. 

Clicking on the tabs at the top of the Editor toggles 
between Job Details, Team, Nominated Sub Contracts* 
and Sectional Completion* information. *Displayed only if 
appropriate to the form of contract.
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Opening forms 
The Job Details panel lists all of the draft and issued forms 
for the job. Click on the headings to expand and collapse the 
list of individual forms. Double click on a form to open it in 
the Editor. If the form has previously been issued it will open 
read-only in the Editor.

Creating a new job

Creating a job 
If the job list is displaying the demo jobs, select Jobs from 
the View menu. Click on the Create New Job icon.       
A new job is created and the Job Details load in the Editor 
for completion. Enter the job details information. Note that 
mandatory fields are indicated with an asterisk (*). The 
Output Location defines where copies of all issued forms 
and transmittal slips will be created in PDF format. This can 
be set to any directory on your local machine or network. 
Click on the button to browse to a different location if 
required. You can create your own demo jobs by ticking the 
Demo Job checkbox.

Job team 
The companies and staff associated with a job are allocated 
on the Team tab at the top of the Editor. The roles, such as 
Employer and Contractor, are listed and once companies 
have been assigned to them they are automatically entered 
on every form. To assign companies to a job, click on the 
Team Member button next to the role and select a company 
from the drop-down list. If the company is not listed, add it to 
the Address Book by going to Tools>Address Book and 
clicking on the New company button.
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Adding and editing forms 
When creating a job, you specify the desired form of contract. 
The forms available in the contract will then be displayed in 
the form library which is located at the bottom of the left hand 
panel. Click on a form to highlight it and then drag-and-drop 
to add it to the main pane. The form will be added to the 
active job and open it for editing. Note that adding forms to a 
job for the first time will lock the Form of Contract and any 
Advance Payment. Guidance about the form will 
automatically open in the Guidance pane together with 
editorial guidance on how to complete the form.

Address book 
Companies and company contacts can be added and 
edited in the Address Book by going to 
Tools>Address Book. Adding companies to the Address 
Book makes them available for all jobs. The companies and 
their roles for each job are listed and edited in the Team tab 
of the Job Details.

Reports 
NBS Contract Administrator can create reports for the 
financial position and contract communications for each job. 
The reports for the active job are available by selecting a 
report title from the Job menu.
 

Issuing forms 
Once you have edited the content of a form and are ready to 
issue it, click on the Distribution List tab at the top of the 
editor. Tick the checkboxes for the companies who are to 
receive copies of the forms; this information will appear on the 
transmittal sheet which is automatically generated when the 
form is issued. 

To issue the form, click on the issue button         at the top of 
the Editor. Note that issuing the first form for a job locks some 
of the information in the job details for Quality Assurance 
purposes. It is possible to recall the last issued form for 
amendments at a later time by opening the form and clicking 
on the recall button.

You will be prompted to enter an issue reason which will be 
included on the transmittal sheet. The issued form and 
transmittal sheet are generated as PDF documents and 
saved in the Output Location folder. You can either print the 
forms and post copies to the relevant parties or send the PDF 
files electronically. 
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NBS Perspective

NBS Perspective is a new document management and 
collaboration system designed to make it easier for you and 
your teams to view, organise and share information and 
project documentation.

As part of your subscription to NBS Scheduler, you now have 
access to at least one free licence to the Professional Edition 
of NBS Perspective.

The free of charge licence(s) can be used until your next 
renewal date plus another 12 months. During this time 
additional Professional Edition licences can be purchased. 
After this time you can continue to use the Project Edition 
free of charge or subscribe to the Professional Edition. For 
prices or information relating to free of charge licences, 
please contact the NBS Customer Services team on 
0845 456 9594.
 
View 
NBS Perspective has a powerful document viewer that 
enables you to view and print hundreds of document 
types, including NBS specifications, without taking time to 
launch or using a licence of the native software. The Viewer 
also contains an intuitive tool bar that synchronises to the 
document type being viewed. 
 

By using the NBS Perspective Viewer, those in your office 
and wider project teams, that only need to view and print 
NBS specifications can now do so using NBS Perspective, 
without needing to launch or use a licence of NBS Scheduler. 
When viewing an NBS specification, the Viewer toolbar 
synchronises to provide tools relevant to an NBS specification. 
 
The NBS Perspective Viewer also views AutoCAD and 
MicroStation drawings, PDFs and Microsoft Office files. 
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Organise 
NBS Perspective can help you to quickly organise information 
and project documentation to suit an individual or office style 
without the risk of deleting or losing original files. It 
re-creates existing project folder structures with virtual 
links back to those folders and their contents. You can add, 
remove, rename, and change the structure of the folders 
without changing the existing project folders or their original 
locations.

Share 
NBS Perspective enables you to electronically record and 
send a complete issue of documents that is too big for email, 
without spending time splitting the pack into several emails or 

delaying the issue by sending it by post. Also there is no need 
to spend time converting files to other formats, as recipients 
can have free access to the NBS Perspective viewer too. 
 
To get started using NBS Perspective, open the software and 
follow the on-screen help or consult your NBS Perspective 
Getting Started guide. 

For more information about NBS Perspective visit 
www.theNBS.com/NBSPerspective or call NBS Customer 
Services on 0845 456 9594.
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Recommended minimum requirements

NBS software requires the following components in order to 
run: 
• Microsoft Internet Explorer 6 (IE6) or Higher – we 			
	 recommend Internet Explorer 7 which can be downloaded 	
	 for free from the Microsoft website 
• Microsoft .NET framework 2.0 – which is included in the 		
	 installation of this product 

All products require a CD-ROM drive if installing the software 
from CD. 

In addition the software will run on the following platforms: 
• Windows Vista 32-bit and 64-bit (SP1) 
• Windows XP Professional (SP3)  
• Windows XP Home (SP3)  
• Windows XP Pro x64 (SP2)  
• Windows 2000 (SP4 with Update Rollup 1)  
• Windows 2000 Server and above (for Server PCs) 
 
Our software support team can provide assistance, and you 
can contact them on 0845 456 9594 (+44 191 232 9594 
from outside the UK) and at support@theNBS.com. 

Please note that the speed of running any software 
application depends upon several factors. The following 
specification is an approximate guide only. 

Recommended minimum requirements for all NBS software: 
• Processor: Pentium III 1.0GHz  
• Memory: 256 MB (For Windows 2000/XP) 512Mb (For 		
	 Windows Vista)  
• Free disk space: 1Gb  
• Screen resolution: 1024 x 768 in 32 bit colour 
   
Apple Macintosh 
We have recently tested the compatibility of NBS software 
with Apple Boot Camp. The specification of the machine 
tested on is as follows: 
• iMac 1.83GHz Intel Core Duo  
• 17-inch widescreen LCD with 1440x900 resolution  
• 1.83GHz Intel Core Duo with 2MB shared L2 cache  
• 2.0Gb 667MHz DDR2 SDRAM  
• 160GB Serial ATA hard drive  
• Slot-load 8x double-layer SuperDrive  
• ATI Radeon X1600 graphics with 128MB GDDR3 memory  
• Built-in AirPort Extreme and Bluetooth 2.0  

Please Note: In order to run NBS software using Apple 
Boot Camp users will require a bona fide full version of 
Microsoft Windows: XP Home or Professional with 
Service Pack 3, Windows Vista Home Basic, Home 
Premium, Business, or Ultimate with Service Pack 1. 
(No upgrade or multi-disc versions). 
Although the software has been successfully tested on this 
platform we cannot guarantee that the software will react the 
same with another specification Mac.  
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Further help and support

NBS is committed to providing excellent customer support. 
Further help and support for NBS Contract Administrator is 
available in the following ways:

Software help files 
Select Help Topics from the Help menu for extensive help 
information about how to use the software. 

Contract administration guidance  
Detailed information and advice about contract administration 
and how to complete the forms is provided in the Guidance 
and Editorial Guidance windows.

NBS Online 
The NBS website has a dedicated area for subscribers that 
includes support information, hints and tips for how to get the 
most out of the software, technical information and more. Visit 
www.theNBS.com or click on theNBS.com tab in the startup 
page of the software for further information. 

Customer Services  
For general enquiries or to licence the software, telephone 
NBS Customer Services on 0845 456 9594. 

Software Support  
For assistance and advice regarding the NBS Contract 
Administrator software, contact NBS Software Support on 
0845 456 9594 or visit 
www.theNBS.com/support/softwaresupport

Feedback 
NBS welcomes feedback about NBS Contract Administrator 
and other NBS products. Please send any comments and 
suggestions to Feedback@theNBS.com
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